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Maka apabila engkau telah selesai (dari sesuatu urusan), tetaplah bekerja keras (untuk
urusan yang lain), dan hanya kepada Tuhanmulah engkau berharap.
(Q.S. Al Insyirah : 6-8)"

“Understanding is the first step to acceptance, and only with acceptance can there be
recovery”. Memahami adalah langkah awal untuk menerima, dan hanya dengan
menerima kita dapat memperbaiki diri. (Dumbledore) ™

“) Departemen Agama Republik Indonesia. 2013. Al-Qur’an dan Terjemahannya.
Solo: PT Tiga Serangkai Pustaka Mandiri.
) Rowling, J.K. 2005. Harry Potter and the Goblet of Fire (Vol. 4). London: Bloomsbury.
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Perkembangan dalam ilmu pengetahuan dan teknologi membawa dampak
pada masyarakat yang cenderung menyukai makanan yang enak dan praktis. Oleh
karena itu, bahan tambahan makanan seperti Monosodium Glutamat (MSG) semakin
banyak digunakan. Menurut BPOM, konsumsi MSG tidak menimbulkan bahaya
terhadap kesehatan. Hal ini cukup bertentangan dengan banyak penelitian yang
menemukan bahwa MSG dapat memberikan dampak negatif bagi tubuh. MSG dapat
menyebabkan gangguan endokrin yang akan mengganggu proses pertumbuhan dan
perkembangan gigi yang dapat menyebabkan defek pada struktur enamel. Penilitian
ini bertujuan untuk mengetahui pengaruh pemberian MSG pada induk tikus wistar
(Rattus norvegicus) terhadap kerusakan struktur enamel gigi keturunannya (F1).

Penelitian ini merupakan penelitian eksperimental laboratoris dengan
rancangan penelitian the post-test only control group design. Terdapat 3 kelompok
penelitian, yaitu anak tikus jantan yang lahir dari induk yang tidak diberikan MSG
(kontrol), anak tikus yang lahir dari induk yang diberikan MSG pada periode hamil,
dan anak tikus yang lahir dari induk yang diberikan MSG pada periode hamil dan
menyusui (21 hari post partum) dengan masing — masing kelompok terdiri dari 5
sampel. Penelitian diawali dengan memberikan MSG peroral pada induk tikus hamil
kelompok perlakuan. Pemberian MSG dilakukan setiap hari sejak hari ke-5
kehamilan tikus betina sampai partum pada kelompok kedua, dan sampai masa laktasi
pada kelompok ketiga (21 hari setelah melahirkan). Induk tikus yang hamil pada
kelompok 1 (kontrol) tidak diberikan MSG. Anak tikus jantan dari seluruh kelompok
didekapitasi pada usia 21 hari. Rahang bawahnya diambil dan dicabut gigi molar 1

kanannya. Sampel gigi molar tersebut diamati dengan menggunakan Scanning
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Electrone Microscope (SEM) perbesaran 5000x. Gambar dari uji SEM diolah
menggunakan software ImageJ 1.49V dengan hasil yang keluar adalah persen area
porositas.

Data hasil penelitian kemudian ditabulasi dan dianalisis secara statistik. Nilai
rata — rata jumlah area porositas kelompok yakni kelompok 1 sebesar 7,039%,
kelompok 2 sebesar 13,909%, dan kelompok 3 sebesar 18,147%. Dilakukan uji beda
One Way Annova yang hasilnya terdapat perbedaan bermakna (p<0,05). Selanjutnya,
dilakukan uji lanjutan Post Hoc LSD yang hasilnya didapatkan perbedaan bermakna
antara kelompok 1 dengan kelompok 2, kelompok 1 dengan kelompok 3, dan juga
kelompok 2 dengan kelompok 3 (P<0,05).

Hasil analisis statistik menunjukkan bahwa terdapat kerusakan struktur
enamel berupa penambahan area porositas yang signifikan pada gigi anak tikus wistar
kelompok perlakuan dibandingkan kelompok kontrol. Hal ini disebabkan MSG dapat
merusak nukleus arkuata hipotalamus dan menyebabkan pengurangan berat kelenjar
hipofisis dan tiroid. Hal tersebut menyebabkan reduksi hormon GH dan TSH.
Kekurangan GH berdampak pada gangguan perkembangan dan mineralisasi gigi,
sedang kekurangan TSH mengakibatkan hipotiroid yang menyebabkan defek pada
struktur enamel. Berdasarkan hasil penelitian dan analisis data, dapat disimpulkan
bahwa pemberian Monosodium Glutamat pada induk tikus tikus wistar selama hamil
dan menyusui berpengaruh dalam peningkatan porositas dan kerusakan struktur

enamel gigi molar tikus neonatal yang dilahirkan.
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BAB 1. PENDAHULUAN

1.1 Latar Belakang

Perkembangan dalam ilmu pengetahuan dan teknologi membawa dampak dalam
berbagai perubahan gaya hidup dan kebutuhan masyarakat. Salah satunya adalah
perubahan pola konsumsi dimana masyarakat cenderung menginginkan makanan
enak dengan cara yang praktis. Oleh karena itu, penggunaan bahan tambahan
makanan banyak sekali digunakan seperti senyawa L-asam glutamat yang digunakan
dalam bentuk garamnya yaitu Monosodium Glutamat (MSG) (Rodriguez et al.,
2003).

Monosodium Glutamat (MSG) adalah garam natrium yang berikatan dengan
asam amino berupa asam glutamat. Monosodium Glutamat (MSG) berbentuk kristal
putih yang stabil, tetapi dapat mengalami degradasi oleh oksidator kuat (Nuryani dan
Jinap, 2010). Monosodium Glutamat (MSG) telah dikonsumsi secara luas di seluruh
dunia sebagai penambah rasa makanan dalam bentuk garam L-glutamic acid, karena
penambahan MSG akan membuat rasa makanan menjadi lebih lezat (Prawirohardjono
et al., 2000). Masyarakat Indonesia rata-rata mengkonsumsi MSG sekitar 0,6 g/kg
BB setiap harinya (Prawirohardjono et al., 2000). Artinya dalam sehari dengan berat
badan 50 kg, rata rata masyarakat mengkonsumsi sekitar 30 gram MSG. Ditambah
dengan tidak adanya batasan spesifik dari Badan Pengawas Obat dan Makanan
(BPOM) atas konsumsi MSG. Peraturan Kepala Badan Pengawas Obat Dan Makanan
Republik Indonesia Nomor 23 Tahun 2013 Pasal 4 tentang batas maksimum
penggunaan bahan tambahan pangan penguat rasa menyatakan, asupan harian yang
dapat diterima atau Acceptable Daily Intake (ADI) dari bahan tambahan pangan jenis
asam L-glutamat dan garamnya adalah not specified/ADI not limited/ADI
acceptable/no ADI Allocated/no ADI necessary adalah istilah yang digunakan untuk
bahan tambahan pangan yang mempunyai toksisitas sangat rendah secara kimia,
biokimia, toksikologi dan data lainnya. Joint FAO/WHO Expert Committee on Food

Additives (JECFA) menyatakan bahwa jumlah asupan bahan tambahan pangan yang
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digunakan untuk mencapai efek yang diinginkan tidak menimbulkan bahaya terhadap
kesehatan. Hal ini cukup bertentangan dengan banyak penelitian yang menemukan
bahwa MSG dapat memberikan dampak negatif bagi tubuh.

Menurut Setiawati (2008), konsumsi MSG berlebihan pada sebagian populasi
dapat menimbulkan beberapa gejala sakit antara lain rasa panas, rasa tertusuk-tusuk
pada wajah dan leher, dada sesak, dan bercak pada kulit yang dikenal dengan sebutan
Chinese Restaurant Syndrome. Efek langsung yang timbul setelah mengkonsumsi
MSG telah dilaporkan terjadinya MSG- Symptom Complex, yang gejalanya timbul
setelah satu jam mengkonsumsi MSG 3 g, terutama bila dikonsumsi pada saat perut
kososng. MSG Symptom complex ditandai dengan rasa terbakar dan kebas di belakang
leher, lengan, dan dada, hangat di wajah dan pundak, rasa nyeri di dada, sakit kepala,
mual, denyut jantung meningkat, bronchospasme (Maidawilis, 2010).

Penelitian lain menyebutkan bahwa MSG juga menyebabkan penurunan
kandungan histamin, merusak sel — sel saraf hipotalamus, yang dapat merubah
kontrol neural dari sekresi hormon yang diproduksi oleh kelenjar hipotalamus —
hipofisis (Aisha, 2014). Glutamat akan berinteraksi dengan reseptor N-methyl-D-
aspartate (NMDA) sehingga akibat interaksi glutamat dengan reseptor NMDA
tersebut dapat menyebabkan degenerasi nukleus arkuata pada hipotalamus. Keadaan
tersebut dapat memicu gangguan endokrin (Park et al., 2000).

Penyuntikan MSG pada mencit betina secara subkutan pada masa postnatal dapat
menurunkan berat kelenjar — kelenjar endokrin yaitu pada kelenjar hipofisis, tiroid,
ovarium, dan testis (Trentini dan Botticelli dalam Maidawilis 2010). Disamping itu
MSG dapat menyebabkan gangguan endokrinal melalui mekanisme hipotalamus-
hipofisis (Hermanussen et al., 2006).

Kelenjar hipofisis disebut sebagai master gland karena mensekresi hormon yang
mengendalikan sekresi hormon oleh kelenjar endokrin lainnya. Kelenjar hipofisis
lobus anterior menghasilkan hormon mayor yaitu growth hormone (GH) dan thyroid-
stimulating hormone (TSH) yang sekresinya distimulasi oleh hormon — hormon dari

kelenjar hipotalamus growth hormone-releasing hormone (GHRH) dan thyrotophin-
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releasing hormone (TRH). Sehingga gangguan pada kelenjar hipotalamus dapat
menyebabkan gangguan pada GH dan TSH (Griffin dan Ojeda, 2004). Gangguan
pada GH dapat mempengaruhi perkembangan dan mineralisasi gigi, oleh karena
reseptor GH berperan penting pada sel preameloblas yang sedang berproliferasi dan
berdiferensiasi (Sassaki, 2003). Kekurangan GH dapat menyebabkan penurunan
ekspresi RNA pada sel — sel preameloblas (Sassaki, 2003). Disamping itu,
kekurangan GH juga mengakibatkan penurunan sintesis proteoglikan. Proteoglikan
akan membentuk matriks ekstraseluler yang berperan penting dalam mineralisasi gigi.
Sehingga gangguan pada proses ini dapat mempengaruhi perkembangan dan
mineralisasi gigi (Sassaki, 2003). Gangguan pada TSH bisa menyebabkan
hipotiroidism (Griffin dan Ojeda, 2004). Bila terjadi pada fase prenatal ataupun
postnatal dapat menghambat proses perkembangan gigi yaitu terjadinya defek enamel
pada masa pertumbuhan selanjutnya (Sassaki, 2003)

Defek enamel atau kerusakan struktur enamel merupakan suatu keadaan
menurunnya kualitas enamel yang menyebabkan kerapuhan pada enamel yang dapat
mempermudah terjadinya kerusakan pada struktur gigi. Salah satu contohnya adalah
hipoplasia enamel (Seow et al., 2005). Hipoplasia enamel adalah berkurangnya
komposisi enamel dibandingkan normal yang disebabkan akibat kurangnya jumlah
matriks pembentuk enamel (Seow et al., 2005). Komposisi enamel terdiri dari 1%
air, 2% bahan organik dan 97% mineral. Dimana zat anorganik yang utama berupa
hidroksiapatit [Ca10(PO4)s(OH),] yang tersusun atas komponen — komponen kalsium
fosfat (Berkovitz et al., 2009). Kelainan ini dapat menyebabkan porositas pada
permukaan gigi, baik terlokalisir maupun pada seluruh gigi dan dapat juga
menyebabkan bentuk gigi yang tidak sempurna (Seow et al., 2005).

Berdasarkan uraian di atas, maka peneliti tertarik untuk meneliti pengaruh
pemberian MSG secara peroral selama fase gestasi hingga fase partum dan laktasi
terhadap kerusakan struktur enamel dalam hal ini porositas enamel dengan
menggunakan hewan coba. Adapun hewan coba yang digunakan adalah tikus wistar

(Rattus norvegicus), karena hewan coba mudah didapat, harga relatif murah,
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pemeliharaan tidak terlalu sulit, biaya perawatan murah, ukuran gigi cukup besar dan

tikus juga dapat digunakan untuk mewakili mamalia termasuk manusia.

1.2 Rumusan Masalah

Berdasarkan latar belakang yang telah diuraikan di atas maka dapat dirumuskan
permasalahan yaitu :
Bagaimana pengaruh pemberian MSG pada induk tikus wistar (Rattus norvegicus)

terhadap kerusakan struktur enamel gigi keturunannya (F1)?

1.3 Tujuan Penelitian
Mengetahui pengaruh pemberian MSG pada induk tikus wistar (Rattus

norvegicus) terhadap kerusakan struktur enamel gigi keturunannya (F1).

1.4 Manfaat Penelitian

1.4.1 Memberikan informasi kepada masyarakat mengenai pengaruh pemberian
MSG pada induk tikus wistar (Rattus norvegicus) hamil terhadap kerusakan
struktur enamel gigi keturunan generasi pertamanya (F1).

1.4.2 Dapat digunakan sebagai bahan penelitian lebih lanjut.
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BAB 2. TINJAUAN PUSTAKA

2.1 Definisi Monosodium Glutamat (MSG)

Monosodium glutamat adalah garam natrium yang berikatan dengan asam amino
berupa asam glutamat. MSG berbentuk kristal putih yang stabil, tetapi dapat
mengalami degradasi oleh oksidator kuat (Nuryani dan Jinap, 2010). MSG
merupakan bentuk garam yang banyak digunakan dari senyawa senyawa L-asam
glutamat (Rodriguez et al., 2003).

Monosodium Glutamat (MSG) biasa digunakan sebagai bahan tambahan pangan
(BTP). BTP sendiri merupakan adalah bahan yang ditambahkan ke dalam pangan
untuk mempengaruhi sifat atau bentuk pangan (BPOM, 2013).

Penguat rasa (Flavour enhancer) adalah bahan tambahan pangan untuk
memperkuat atau memodifikasi rasa dan/atau aroma yang telah ada dalam bahan
pangan tersebut tanpa memberikan rasa dan/atau aroma tertentu (BPOM, 2013).
MSG telah dikonsumsi secara luas di seluruh dunia sebagai penguat rasa makanan
karena penambahan MSG akan membuat rasa makanan menjadi lebih lezat (Rangkuti
et al., 2012). Ada MSG terdapat suatu komponen L-glutamat dan 5-ribonukleotida.
Rangsangan selera dari makanan yang diberi MSG disebabkan oleh kombinasi rasa
yang khas dari efek sinergis MSG dengan komponen 5-ribonukleotida yang terdapat
di dalam makanan, yang bekerja pada membran sel reseptor kecap atau lidah
(Wakidi, 2012). Oleh karena itu penambahan MSG akan membuat rasa makanan
menjadi lebih lezat (FSANZ, 2003). Pemberian bahan tambahan pangan termasuk
MSG boleh diberikan secukupnya yang diperlukan hanya untuk menghasilkan efek
yang diinginkan (BPOM, 2013).

2.2 Sejarah MSG
MSG ditemukan pertama kali pada tahun 1909, oleh seorang ahli kimia yang
berasal dai Jepang yang bernama dr. Kikunae lkeda. Ikeda mengisolasi asam

glutamate yang berasal dari rumput laut (genus Laminaria) dan disebut ‘kombu’di
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Jepang (Halpern, 2002). Kemudian dia menemukan rasa lezat dan gurih yang berbeda
dengan rasa yang pernah dikenalnya. Oleh karena itu, Ikada menyebut rasa itu dengan
sebutan ‘umami’ yang berasal dari bahasa Jepang 'umai’ yang berarti enak dan lezat.
Rasa umami ini dapat bertahan lama, di dalamnya terdapat suatu komponen L-
glutamat dan 5-ribonukleotida yang dapat menggugah selera makan (Wakidi, 2012).

Pada tahun 1970 Food and Drug Administration (FDA) menetapkan batas aman
konsumsi MSG yaitu 120 mg/kg berat badan per hari dan tidak boleh diberikan
kepada bayi kurang dari 12 minggu. Pada tahun 1986 FDA menyatakan bahwa
mengkonsumsi MSG itu aman hingga pada tahun 1987 WHO menghapus batasan
penggunaannya dalam sehari-hari. Hal itu menyebabkan MSG yang dijual di pasaran
tidak disertai petunjuk takaran dalam hal penggunaannya yang kemudian
menyebabkan konsumsi MSG menjadi tidak terbatas pada makanan (Budiarso, 2003).
Oleh karena itu, Penggunaan bahan tambahan makanan banyak sekali digunakan
(Rodriguez et al., 2003). Berbagai merk dagang MSG telah dikenal di masyarakat
secara luas seperti ajinomoto, vetsin, micin, sasa, miwon dan sebagainya (Maidawilis,
2010).

2.3 Sifat Kimia MSG
MSG mempunyai rumus kimia CsHgO4sNNaH,0. Komposisi MSG terdiri atas
Natrium sebanyak 12%, glutamate 78% dan air 10% (Loliger, 2000).

O

OH

Gambar 2.1 Struktur Kimia MSG
Sumber: Loliger, 2000
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MSG bersifat larut dalam air (Geha, 2000), glutamat yang terdapat dalam MSG
merupakan suatu asam amino yang banyak dijumpai pada beberapa makanan,
kandungan glutamate 20% dari total asam amino pada beberapa makanan baik bebas
maupun terikat dengan peptida atau protein (Fernstrom, 2000). Sedangkan glutamat
yang terdapat di dalam MSG dan yang berasal dari hidrolisa protein tumbuhan
merupakan glutamate dalam bentuk bebas. Dimana konsumsi glutamat bebas akan
meningkatkan kadar glutamate dalam plasma darah (Gold dalam Maidawilis 2010).
Asam amino non esesial seperti glutamate dimetabolisme secara menyebar luas
dalam jaringan tubuh. 57% dari asam amino yang diabsorpsi dirubah menjadi urea
melalui hati, sedangkan 6% menjadi plasma protein, 23% diabsorpsi melalui sirkulasi
umum sebagai asam amino bebas, dan sisanya 14% tidak dilaporkan dan diduga
disimpan sementara di dalam hati sebagai protein hati atau enzim (Sukawan, 2008).
Rasa yang dihasilkan oleh MSG sendiri sebenarnya tidak menghasilkan rasa yang
enak. Namun apabila ditambahkan dengan konsentrasi rendah pada makanan yang
sesuai maka dapat meningkatkan rasa, kenikmatan dan penerimaan terhadap makanan
tersebut (Halpern, 2002).

2.4 Efek Biologis MSG

MSG telah banyak dikonsumsi oleh masyarakat Indonesia, bahkan telah mencapai
sekitar 0,6 g/kg BB setiap harinya (Prawirohardjono et al., 2000). Artinya dengan
berat badan 50 kg, dalam sehari rata - rata masyarakat mengkonsumsi sekitar 30 gram
MSG. Sementara itu, Badan Pengawas Obat dan Makanan (BPOM) sendiri tidak
memberikan batasan spesifik atas konsumsi MSG.

Menurut Peraturan Kepala Badan Pengawas Obat Dan Makanan Republik
Indonesia Nomor 23 Tahun 2013 Pasal 4 tentang batas maksimum penggunaan
bahan tambahan pangan penguat rasa, asupan harian yang dapat diterima atau
Acceptable Daily Intake (ADI) dari bahan tambahan pangan jenis asam L-glutamat
dan garamnya adalah ADI not specified. ADI tidak dinyatakan atau ADI not specified
adalah istilah yang digunakan untuk bahan tambahan pangan yang mempunyai
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toksisitas sangat rendah, berdasarkan data (kimia, biokimia, toksikologi dan data
lainnya), jumlah asupan bahan tambahan pangan tersebut jika digunakan dalam
takaran yang diperlukan untuk mencapai efek yang diinginkan serta pertimbangan
lain, menurut pendapat Joint FAO/WHO Expert Committee on Food Additives
(JECFA) tidak menimbulkan bahaya terhadap kesehatan.

Selain itu, badan Pengawas Makanan dan Obat-obatan (Food and Drugs
Administration, FDA) Amerika Serikat mengklasifikasikan MSG sebagai bahan yang
aman untuk dikonsumsi, seperti bahan makanan lainnya, misalnya garam, cuka, dan
pengembang kue (FDA, 2013). Namun demikian, berbagai penelitian juga
melaporkan adanya efek yang timbul setelah mengkonsumsi MSG. Misalnya MSG-
Symptom Complex yang timbul setelah satu jam mengkonsumsi MSG sebesar 3 g
melalui makanan, terutama jika dikonsumsi dalam kondisi perut kosong. MSG
Symptom complex ditandai dengan rasa terbakar dan kebas di belakang leher, lengan,
dan dada, hangat di wajah dan pundak, rasa nyeri di dada, sakit kepala, mual, denyut
jantung meningkat, bronchospasme (Maidawilis, 2010). Federation of American for
Experimental (FASEB) juga melaporkan adanya dua kelompok orang yang
cenderung mengalami MSG- Symptom Complex, kelompok pertama orang yang
tidak toleran terhadap konsumsi MSG dalam jumlah besar dan kelompok kedua
orang dengan penyakit asma tidak terkontrol, orang-orang ini cenderung mengalami
MSG- Symptom Complex, perburukan gejala asma yang bersifat sementara setelah
mengkonsumsi MSG dengan dosis antara 0,5 g sampai 2,5 g (Geha, 2000).

MSG berlebihan pada sebagian populasi masyarakat dapat menimbulkan
beberapa gejala sakit antara lain rasa panas, rasa tertusuk-tusuk pada wajah dan leher,
dada sesak, dan bercak pada kulit yang dikenal dengan sebutan Chinese Restaurant
Syndrome (Setiawati, 2008).

Nizamuddin (2000) telah melakukan penelitian mengenai pengaruh pemberian
MSG per oral pada berat badan dan berat testis tikus jantan dengan dosis 2400 mg/kg,
4800 mg/kg, dan 9600 mg/kg berat badan pada kelompok perlakuan ke tiga yang
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masing-masing dosis dilarutka dalam 4 mg akuades. Hasil penelitian setelah 49 hari
ternyata MSG dapat mempengaruhi berat testis tikus.

Selain itu, pemberian MSG secara suntikan subkutan pada mencit baru lahir dapat
menimbulkan terjadinya nekrosis neuron akut pada otak termasuk hipotalamus yang
ketika dewasa akan mengalami hambatan perkembangan tulang rangka, obesitas,dan
sterilitas pada betina (Ganesan et al., 2013). Selanjutnya, dilaporkan bahwa MSG
menyebabkan penurunan kandungan histamin yang signifikan dalam sistem saraf
pusat (Aisha, 2014). Penelitian lain menyebutkan bahwa MSG dapat menyebabkan
lesi pada otak (Aisha, 2014).

Sebuah penelitian yang dilakukan pada mencit betina yang diberikan perlakuan
penyuntikan MSG secara subkutan pada masa postnatal menyebutkan bahwa MSG
menyebabkan stres oksidatif yang memberikan dampak pada penurunan berat
kelenjar — kelenjar endokrin yaitu pada kelenjar hipofisis, tiroid, ovarium, dan testis
(Trentini dan Botticelli dalam Maidawilis, 2010). Selain itu, beberapa peneliti lain
mengatakan bahwa MSG dapat menyebabkan gangguan endokrinal melalui
mekanisme hipotalamus-hipofisis (Hermanussen et al., 2006).

Kelenjar hipofisis disebut sebagai master gland karena mensekresi hormon yang
selanjutnya akan mengendalikan sekresi hormon oleh kelenjar endokrin lainnya.
Kelenjar hipofisis lobus anterior menghasilkan beberapa hormon mayor diantaranya
growth hormone (GH) dan thyroid-stimulating hormone (TSH). Sekresi dari GH dan
TSH distimulasi oleh hormon — hormon dari kelenjar hipotalamus yaitu growth
hormone-releasing hormone (GHRH) dan thyrotophin-releasing hormone (TRH).
Mekanisme inilah yang disebut mekanisme hipotalamus-hipofisis(Griffin dan Ojeda,
2004). Pemberian MSG dapat menyebabkan gangguan endokrinal seperti pada GH
dan TSH melalui mekanisme ini (Hermanussen et al., 2006).

Gangguan pada GH dapat mempengaruhi perkembangan dan mineralisasi gigi,
sebab reseptor GH terdapat pada sel preameloblas yang sedang membelah dan sel
preodontoblas yang sedang berdiferesiasi (Sassaki, 2003). Kekurangan GH dapat
menyebabkan penurunan ekspresi RNA pada preameloblas dan preodontoblas
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(Sassaki, 2003). Disamping itu, kekurangan hormon ini juga mengakibatkan
penurunan sintesis proteoglikan. Proteoglikan akan membentuk matriks ekstraseluler
yang berperan penting dalam mineralisasi gigi. Sehingga gangguan pada proses ini
dapat mempengaruhi perkembangan dan mineralisasi gigi (Sassaki, 2003).

Gangguan pada TSH mempengaruhi sekresi pada kelenjar yang distimulasinya
yaitu kelenjar tiroid (Griffin dan Ojeda, 2004). Prenatal ataupun postnatal
hipotirodism yang dapat menghambat proses perkembangan gigi, yang akan

mengarah pada defek enamel dalam masa pertumbuhan selanjutnya (Sassaki, 2003).

2.5 Tahapan Perkembangan Gigi

Perkembangan gigi dimulai sejak dalam kandungan sekitar 28 hari intrauterin
(Holt et al., 2000). Gigi sulung berkembang pada minggu ke-6 dan minggu ke-8
sedangkan gigi permanen berkembang pada minggu ke-20 (Markman, 2010). Tahap
mineralisasi pada gigi sulung dimulai pada minggu ke-14 1U untuk selanjutnya
seluruh gigi sulung akan termineralisasi secara sempurna setelah kelahiran. Gigi
insisivus permanen dan molar pertama permanen termineralisasi pada waktu setelah
kelahiran, setelah itu baru gigi — gigi permanen lain akan mengalami mineralisasi
(Holt et al., 2000).

Secara embriologi, gigi berasal dari dua jaringan. Ektoderm yang akan
membentuk enamel dan mesoderm yang akan membentuk dentin, sementum, dan
pulpa (Mokhtar, 2005). Epitel ektoderm yang melapisi kavum oris mengalami
penebalan sepanjang tepi dari bakal rahang atas dan rahang bawah. Hal ini terjadi
pada minggu ke-5 masa embrio. Penebalan ini terdiri atas dua lapisan yang meluas
sampai ke mesenkim, dimana lapisan pertama yang berada di sebelah labial akan
memisahkan diri dan membentuk ruangan di antara bibir dan prosesus alveolaris dari
rahang. Sedangkan lapisan kedua yaitu di sebelah lingual akan membentuk gigi yang
disebut lamina dentalis. Pada lamina dentalis, terjadi penebalan yang berbentuk
kuncup dan masuk ke dalam jaringan pengikat (mesoderm). Kuncup — kuncup ini

merupakan benih — benih gigi. Terdapat 10 benih — benih gigi dalam masing —
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masing tulang rahang yang akan menjadi gigi sulung. Pada awal minggu ke-10
lamina dentalis yang masih tinggal akan membentuk kuncup — kuncup lagi yang
akan menjadi benih — benih gigi permanen (Mokhtar, 2005).

Selanjutnya, benih gigi tersebut akan muncul ke dalam rongga mulut atau yang
biasa disebut dengan erupsi gigi. Erupsi gigi adalah suatu proses pergerakan gigi
secara aksial yang dimulai dari tempat perkembangan gigi di dalam tulang alveolar
sampai akhirnya mencapai posisi fungsional di dalam rongga mulut. Erupsi gigi
merupakan suatu proses yang berkesinambungan dimulai dari tahap pembentukkan
gigi sampai gigi muncul ke rongga mulut (Berkovitz et al., 2009). Erupsi gigi terjadi
setelah formasi dan mineralisasi mahkota terbentuk sempurna tetapi sebelum akar
terbentuk sempurna. Gigi tumbuh dari dua tipe sel, yaitu epitel oral dari enamel organ
yang akan membentuk enamel dan sel mesenkim dari papilla dental yang akan
membentuk dentin (Nasution, 2008). Mahkota dan bagian akar dibentuk sebelum gigi
tersebut erupsi. Mahkota dibentuk terlebih dahulu, kemudian baru pembentukkan
akar (Harshanur, 1995).

Perkembangan gigi dibagi dalam 3 tahap, yaitu : tahap pra-erupsi, tahap pra-
fungsional (tahap erupsi), dan tahap fungsional (Berkovitz et al., 2009). Tahap pra-
erupsi, yaitu saat mahkota gigi terbentuk dan posisinya dalam tulang rahang cukup
stabil (intraosseus), ketika akar gigi mulai terbentuk dan gigi mulai bergerak di dalam
tulang rahang ke arah rongga mulut, penetrasi mukosa, dan pada saat akar gigi
terbentuk setengah sampai tiga perempat dari panjang akar (Wahono dan Soenawan,
2009). Menurut Mokhtar (2005), tahapan pra-erupsi terdiri dari :

a. Inisiasi (Bud Stage)

Tahap inisiasi terjadi pada minggu ke-10 IU, merupakan penebalan jaringan
ektodermal dan pembentukkan kuntum gigi yang dikenal sebagai enamel organ.

Perubahan yang paling nyata dan paling dominan adalah proliferasi jaringan

ektodermal dan jaringan mesenkimal yang terus berlanjut.
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b. Proliferasi (Cap Stage)

Dimulai pada minggu ke-11 IU, sel-sel organ enamel masih terus
berproliferasi sehingga organ enamel lebih besar sehingga berbentukan cekung
seperti topi. Bagian yang cekung diisi oleh kondensasi jaringan mesenkim dan
berproliferasi membentuk papila dentis yang akan membentuk dentin. Papila
dental yang dikelilingi oleh organ enamel akan berdiferensiasi menjadi pulpa.
Jaringan mesenkim di bawah papila dental membentuk lapisan yang bertambah
padat dan berkembang menjadi lapisan fibrosa yaitu kantong gigi (dental sakus)
primitif.

c. Histodiferensiasi (Bell Stage)

Tahap bel merupakan perubahan bentuk organ enamel dari bentuk topi
menjadi bentuk bel. Perubahan histodiferensiasi mencakup perubahan sel-sel
perifer papila dental menjadi odontoblas (sel-sel pembentuk dentin). Ada empat
lapisan sel y ang dapat dilihat pada tahap bell, yaitu Outer Enamel Epithelium,
Retikulum Stelata, stratum Intermedium, dan Inner Enamel Epithelium.

d. Morfodiferensiasi

Morfodiferensiasi adalah susunan sel-sel dalam perkembangan bentuk
jaringan atau organ. Perubahan morfodiferensiasi mencakup pembentukkan pola
morfologi atau bentuk dasar dan ukuran relatif dari mahkota gigi. Morfologi gigi
ditentukan bila epitel email bagian dalam tersusun sedemikian rupa sehingga
batas antara epitel email dan odontoblas merupakan gambaran dentinoenamel
junction yang akan terbentuk. Dentinoenamel junction mempunyai sifat khas pada
setiap gigi, sebagai suatu pola tertentu pada pembiakan sel.

e. Aposisi

Aposisi adalah pengendapan matriks dari struktur jaringan keras gigi (email,
dentin, dan sementum). Pertumbuhan aposisi ditandai oleh pengendapan yang
teratur dan berirama dari bahan ekstraseluler yang mempunyai kemampuan
sendiri untuk pertumbuhan yang akan datang. Gangguan pada tahap

pengendapan matriks ini dapat menyebabkan kelainan seperti enamel hipoplasia.
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f. Kalsifikasi

Kalsifikasi terjadi dengan pengendapan garam-garam kalsium anorganik
selama pengendapan matriks. Kalsifikasi akan dimulai di dalam matriks yang
sebelumnya telah mengalami deposisi dengan jalan presipitasi dari bagian ke
bagian lainnya dengan penambahan lapis demi lapis. Gangguan pada tahap ini
dapat menyebabkan kelainan pada kekerasan gigi seperti hipokalsifikasi.

Selanjutnya, gigi akan mengalami tahap erupsi dan tahap fungsional. Erupsi
gigi adalah suatu proses pergeraka gigi secara aksial yang dimulai dari tempat
perkembangan gigi di dalam tulang alveolar sampai akhirnya mencapai posisi
fungsional di dalam rongga mulut (Berkovitz et al., 2009).

2.6 Struktur Enamel Gigi

Enamel merupakan jaringan tubuh dengan susunan kimia kompleks yang
mengandung 97% mineral, 1% air dan 2% bahan organik (Pintauli dan Hamada,
2007). Enamel dibentuk oleh sel yang disebut sebagai ameloblast, yang berasal dari
lapisan embrio yang dikenal sebagai ectoderm. Enamel melapisi bentuk anatomi
mahkota gigi dan ketebalannya berbeda pada setiap daerah. Enamel lebih tebal pada
bagian incisal dan oklusal gigi dan semakin lama semakin menipis pada servikal gigi
sampai mencapai sementoenamel junction (Berkovitz et al., 2009).

Enamel bersifat semitranslusen, berwarna putih kekuningan sampai putih keabu —
abuan tergantung pada ketebalan enamel. Tingkat translusensi enamel juga
berhubungan dengan tingkat kalsifikasi dan homogenitas. Warna enamel penting
dalam menentukan perubahan fisikokimia yang terjadi karena tidak normalnya
kondisi gigi (Sturdevant C et al., 2001).

Komposisi kimia enamel mengandung 97% mineral, 1% air dan 2% bahan
organik. Bagian luar enamel mengalami mineralisasi yang lebih sempurna dan
mengandung banyak fluor, fosfat, dan sedikit karbonat dan air. (Pintauli dan Hamada,
2007). Zat anorganik yang utama berupa hidroksiapatit [Ca;o(PO4)s(OH),] sekitar 90
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- 92% dari volumenya yang tersusun atas komponen — komponen kalsium fosfat
(Berkovitz et al., 2009).

Secara struktural enamel terdiri atas jutaan enamel rod atau prisma yang
merupakan struktur komponen terluas. Prisma ini memanjang dari arah perbatasan
enamel dan dentin ke permukaan enamel, serta saling mengikat satu sama lain. Pada
potongan melintang tampak seperti keyhole yang terdiri atas kepala dan ekor. Arah
prisma ke permukaan tidak lurus melainkan bergelombang. Pada bagian kepala
prisma terdapat kristal hidroksiapatit. Kepadatan kristal enamel sangat menentukan
kelarutan enamel. Semakin banyak enamel mengandung mineral, maka kristal enamel
semakin padat, sedikit porositas dan enamel akan semakin resisten terhadap karies
(Pintauli dan Hamada, 2007).

Gambar 2.2 Enamel Rod Potongan Melintang
Sumber: Sturdevant et al., 2001

2.7 Kerusakan Struktur Enamel

Defek enamel atau kerusakan struktur enamel merupakan suatu keadaan
menurunnya kualitas enamel yang menyebabkan kerapuhan pada enamel yang dapat
mempermudah terjadinya kerusakan pada struktur gigi. Salah satu macam defek
enamel menurut manifestasi klinisnya adalah hipoplasia enamel (Seow et al., 2005).
Hipoplasia enamel adalah kerusakan pada enamel gigi yang mengakibatkan

berkurangnya komposisi enamel berbanding normal. Kerusakan ini dapat berupa
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porositas pada permukaan gigi, baik terlokalisir maupun pada seluruh gigi dan dapat
juga menyebabkan bentuk gigi yang tidak sempurna. Defek enamel ini menyebabkan
permukaan enamel menjadi kasar dan memudahkan penumpukan plak. Penumpukan
plak pada gigi yang mengalami defek ini akan menjadi faktor predisposisi pada
pembentukan karies (Seow et al., 2005).

Kerusakan enamel dapat terjadi karena adanya gangguan yang disebabkan
baik faktor herediter, dan lingkungan baik lingkungan lokal maupun lingkungan
sistemik. Dalam hal faktor genetik yang menjadi penyebab kegagalan perkembangan
gigi, terdapat >100 kelainan genetik yang berhubungan kegagalan perkembangan gigi
sehingga terjadi kelainan struktur enamel (Small dan Murray, 1978). Sedangkan
faktor lingkungan meliputi faktor lokal dan sistemik dapat terjadi pada saat prenatal,

pascanatal, neonatal (Cameron, 2003).

2.8 Tikus Wistar (Rattus norvegicus)

Data biologis tikus adalah sebagai berikut:

Lama hidup : 2-3 tahun, dapat sampai 4 tahun
Lama produksi ekonomis : 1 tahun

Lama hamil : 20-22 hari

Umur dewasa : 40-60 hari

Umur dikawinkan : 10 minggu (jantan dan betina)
Siklus kelamin : polietrus

Siklus estrus : 4-5 hari

Lama estrus : 9-20 jam

Berat lahir :5-6 ¢

Jumlah anak : Rata-rata 9-20 ekor

(Smith dalam Noviantari, 2009).
Tikus wistar merupakan bagian dari tikus albino yang termasuk spesies Rattus
novergicus. Tikus ini memiliki ciri — ciri kepala yang lebar, telinga yang panjang dan

ekor yang selalu lebih pendek daripada panjang tubuhnya. Tikus merupakan hewan
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yang digunakan secara ekstensif sebagai hewan coba untuk mempelajari biologi dan
patologi dari jaringan rongga mulut. Spesies tikus ini telah berguna dalam berbagai
penelitian kedokteran gigi. Tikus ini dapat berguna untuk menjelaskan informasi
biologis yang berharga demi membuktikan pengertian dan mekanisme dasar dari
sebuah penyakit. Di samping itu tikus ini juga berfungsi sebagai fasilitas untuk
eksperimen secara klinis dan epidemiologi yang dimaksudkan untuk memberikan
informasi yang dapat diaplikasikan secara langsung pada manusia. Dalam hal ini
tikus putih merupakan hewan mamalia yang sering digunakan dalam suatu percobaan
dengan perlakuan secara konvensional dikarenakan tikus dapat digunakan untuk
mewakili mamalia termasuk manusia (Baker et al.,1980).

Seperti halnya manusia, tikus juga mengalami siklus estrus. Siklus estrus tikus
berlangsung selama 4-5 hari yang terjadi sepanjang tahun. Siklus estrus terdiri dari
empat tahap yaitu proestrus, estrus, metestrus, dan diestrus. Pemeriksaan mikroskopis
morfologi sel dari smear vagina adalah metode yang secara luas digunakan untuk
mendeteksi fase siklus estrus pada tikus. Pada fase proestrus, sel epitel berbentuk
bulat, terdapat inti dan berbentuk oval dan berada di tengah sel. Fase ini berlangsung
selama 12 jam. Fase estrus pada tikus berdurasi 9-15 jam. Pada fase ini bentuk sel
epitel poligonal, pipih, sitoplasma luas, tidak berinti atau inti sangat kecil dan gelap
(piknotik), sel superfisial tanpa inti seringkali mengalami kornifikasi, pinggiran sel
melipat, kadang ditemukan leuokosit dalam jumlah yang sangat sedikit. Metestrus
terjadi setelah ovulasi dan berakhir kira-kira 21 jam. Selama metestrus, sitologi
vagina mengandung banyak leukosit dan sel yang berinti, serta sel cornified. Diestrus
adalah fase yang paling lama berakhir setelah 57 jam, smear vagina mengandung
leukosit primer dan ditandai dengan sel epitel terkecil dengan bentuk bulat atau agak
bulat. Dari keseluruhan fase pada siklus estrus, fase estrus adalah waktu terbaik
ketika tikus betina siap menerima untuk melakukan kopulasi (Suckow et al., 2006).
2.9.1 Gigi Tikus

Tikus memiliki 16 jumlah gigi yaitu terdiri dari gigi insisivus atas yang

berjumlah 2, insisivus bawah berjumlah 2, molar atas berjumlah 3 dan molar bawah
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yang juga berjumlah 3. Pada pertumbuhan dan perkembangannya, gigi tikus memiliki
kesamaan dengan manusia. Gigi tikus tumbuh dan berkembang melalui interaksi
yang berkelanjutan antara dental epithelium dan neural crest. Pembentukan gigi tikus
dimulai dengan fase inisiasi (placode/initiation), bud stage, cap stage, dan bell stage
(Pagella et al., 2014).

Fase inisiasi terjadi pada janin tikus berusia 10-11 hari intra uterin. Bud stage
terjadi pada usia 12-13 hari intra uterin. Cap stage terjadi pada janin tikus dalam usia
14-15 hari intra uterin dan bell stage terjadi pada usia 16 hari intra uterin sampai
postnatal hari ke-7.

Gigi insisivus tikus terus tumbuh selama hidupnya oleh karena itu tikus
mengerat agar pertumbuhan gigi insisivusnya tetap konstan. Waktu erupsi untuk gigi
tikus putih bervariasi hingga umur 25 hari. Gigi insisivus yang pertama erupsi yaitu
pada umur 8-10 hari setelah lahir. Molar pertama dan molar kedua erupsi sekitar
umur 19-21 hari. Gigi molar ketiga erupsi setelah dua minggu kemudian setelah
erupsi gigi molar pertama dan molar kedua. Gigi insisivus secara permanen terus
tumbuh tanpa ketentuan sedangkan gigi molar memiliki batas waktu dalam hal

perkembangannya (Pagella et al., 2014).

2.9 Scanning Electron Microspcope (SEM)

Scanning Electron Microscope (SEM) adalah alat yang digunakan untuk
mempelajari morfologi permukaan / ukuran butiran. Pengamatan morfologi
permukaan dalam 3 dimensi, resolusi tinggi dan analisa Kimia. Prinsip kerja SEM
(Scanning Electron Microscope) adalah sebagai berikut:

1. Electron Gun ( Sumber Elektron / Penembak elektron)

Penembak elektron yang terdiri dari filamen tungsten, penembak elektron ini
digunakan untuk menghasilkan elektron dalam suatu volume tertentu dengan
energi yang dapat ditentukan dengan mengatur arus listrik ke filamen sehingga
terjadi pelepasan elektron.

2. Demagnetification System (Perangkat Demagnetisasi)
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Perangkat Demagnetisasi terdiri dari gabungan lensa-lensa elektromagnetik
yang digunakan untuk menfokuskan E-Beam menjadi sangat kecil pada saat
mencapai sampel.

3. Scan Unit (Sistem Pelarikan)

Pembentukan Gambar dengan menggunakan prinsip scanning, dimana
elektron diarahkan ke objek, gerakan berkas tersebut mirip dengan “Gerakan
Membaca”. Scan unit dibangkitkan oleh scanning coil, sedangkan hasil interaksi
berkas elektron dengan sampel menghasilkan Secondary Electron (SE) dan
elektron Backs Scattered (BSc), diterima detektor SE/BSc, di ubah menjadi
sinyal, data sinyal diperkuat oleh Video Amplifier kemudian disinkronkan oleh
scanning circuit terbentuklah Gambar pada Tabung Sinar Katoda (CRT). Di layar
CRT inilah dapat terlihat gambar struktur objek yang sudah diperbesar. Selain itu,
mikroskop ini dapat digunakan untuk melihat objek dari sudut pandang 3 dimensi
sehingga pada proses operasinya tidak perlu dilakukan penipisan pada sampel
(Sinuhaji dan Marlianto, 2012).

rY\ senapan elektron
l
\ / anoda {diburmikan)
i s [} apertur
lensa kondenser 1 \ :jer,-!nebar
/1)
EE
L2
=) G lensa kandenser 2
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o \ /

o layz
0 f B }h 1] g
B 11 /

, " photomultiplier (
lensa akhir ot nultiplier I \

o= H_ ] \

kolektor penguat video

Gambar 2.3 Diagram Skematik Fungsi Dasar dan Cara Kerja SEM
Sumber : Nuha, 2008
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2.10 Hipotesa
Terdapat kerusakan struktur enamel pada gigi tikus wistar (Rattus norvegicus)
generasi pertama (F1) yang induknya diberikan MSG selama periode hamil maupun

periode hamil dan menyusui dibandingkan kelompok kontrol.
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Gambar 2.4 Kerangka Konsep Penelitian
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BAB 3. METODOLOGI PENELITIAN

3.1 Jenis Penelitian

Jenis penelitian ini adalah eksperimental laboratoris dengan rancangan the post
test only control group design. Penelitian eksperimen pada prinsipnya dapat
didefinisikan sebagai metode sistematis guna membangun hubungan yang
mengandung fenomena sebab akibat (causal-effect relationship) (Sukardi, 2011).
Metode eksperimen adalah metode penelitian yang digunakan untuk mencari
pengaruh perlakuan tertentu terhadap yang lain dalam kondisi yang dikendalikan
(Sugiyono, 2011).

3.2 Waktu dan Tempat Penelitian
3.2.1 Waktu Penelitian
Penelitian dilaksanakan pada bulan Agustus-Desember 2015.
3.2.2 Tempat Penelitian
Penelitian ini dilakukan di Laboratorium Biomedik Fakultas Farmasi
Universitas Jember dan uji SEM untuk melihat struktur enamel gigi tikus dilakukan

di Laboratorium Sentral FMIPA Universitas Negri Malang.

3.3 Identifikasi VVariabel Penelitian
3.3.1 Variabel Bebas
Variabel bebas pada penelitian ini adalah periode pemberian Monosodium
glutamat (MSG).
3.3.2 Variabel Terikat
Variabel terikat pada penelitian ini adalah struktur enamel gigi tikus yang
induknya diberikan Monosodium glutamat selama hamil dan masa menyusui.
3.3.3 Variabel Terkendali
a. Anak tikus wistar Rattus norvegicus generasi pertama (F1)
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b. Umur tikus wistar : 21 hari

c. Jenis kelamin tikus wistar : Jantan

d. Pakan induk tikus wistar : Pellet

e. Dosis MSG : 1,54 mg/gr BB
f. Merk MSG : AJI-NOMOTO

3.4 Definisi Operasional
3.4.1 Monosodium Glutamat (MSG)

Monosodium glutamat adalah garam sodium dari asam glutamat yang terdiri
dari 78% asam glutamat, 22% natrium dan air, merk yang digunakan adalah AJI-
NOMOTO. Diberikan peroral menggunakan sonde lambung dengan dosis 1,54 mg/gr
BB sebanyak sekali dalam sehari.

3.4.2 Kerusakan Struktur Enamel

Gambaran kerusakan dari kumpulan pangkal enamel rod yang kontak secara
langsung dengan rongga mulut yang porositasnya akan diamati menggunakan SEM.
Hasil dari SEM selanjutnya diolah dengan menggunakan software ImageJ 1.49V dan
hasil yang didapatkan adalah persen area porositas enamel.

3.4.3 Periode Pemberian MSG

Jangka waktu pemberian MSG secara peroral pada induk tikus wistar, yaitu
dilakukan setiap hari sejak hari ke-5 kehamilan induk tikus sampai partum pada
kelompok kedua, dan sampai masa laktasi (21 hari) pada kelompok ketiga.
3.4.4 Induk Tikus Wistar

Tikus wistar (Rattus norvegicus) betina dewasa usia 2-3 bulan yang telah
dikumpulkan dengan jantan dan dinyatakan hamil setelah smear vagina. Dibedakan
menjadi 3 kelompok dimana kelompok 1 tidak diberi MSG, kelompok 2 diberi MSG
secara peroral dengan menggunakan sonde lambung dari hari ke-5 kehamilan sampai
partum, dan kelompok 3 diberikan MSG secara peroral dengan menggunakan sonde

lambung dari hari ke-5 kehamilan sampai masa laktasi (21 hari).
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3.4.5 Anak Tikus Wistar

Tikus wistar (Rattus norvegicus) neonatal generasi pertama berjenis kelamin
jantan yang berasal dari induk seluruh kelompok perlakuan. Didekapitasi pada usia
21 hari dan diamati porositas enamel gigi molar 1 kanan bawahnya menggunakan
SEM.

3.5 Populasi dan Sampel Penelitian
3.5.1 Populasi Penelitian
Populasi penelitian adalah tikus wistar (Rattus norvegicus) neonatal generasi
pertama (F1) dari induk tikus kelompok kontrol dan induk tikus kelompok yang
diinduksi Monosodium glutamat selama masa hamil dan menyusui.
3.5.2 Sampel Penelitian
a. Kriteria Sampel
Kriteria induk tikus yang digunakan pada penelitian ini adalah :
1. Tikus wistar betina
2. Usia 2-3 bulan
3. Berat badan 200-250 gram
Kriteria anak tikus yang digunakan pada penelitian ini adalah :
Anak tikus wistar Rattus norvegicus generasi pertama (F1)
Jenis kelamin jantan
Usia 21 hari
Kondisi sehat dan tidak memiliki kelainan fisik

ok~ 0w DD

Gigi molar rahang bawah erupsi sempurna
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b. Jumlah Sampel Penelitian
Jumlah sampel didapatkan dari perhitungan rumus sebagai berikut (Daniel,
2005) :

Keterangan :

n = besar sampel tiap kelompok

Z = nilai Z pada tingkat kesalahan tertentu, jika a = 0,05 maka Z = 1,96

o = standar deviasi sampel

d = kesalahan yang masih dapat ditoleransi

Dengan asumsi bahwa nilai ¢ sama dengan d (¢ = d), dikarenakan nilai o

jarang sekali diketahui sehingga harus menduganya maka :

7?2
n = 72
n > (1,96)>
n = 3,84
n =4
Hasil yang diperoleh jumlah sampel minimal 4, Pada penelitian ini jumlah
sampel yang digunakan adalah 5 sampel untuk masing-masing kelompok, maka
didapatkan total 15 sampel gigi molar tikus neonatal.
c. Pengelompokan Sampel
Tikus dibagi menjadi tiga kelompok yang terdiri dari 1 kelompok kontrol dan 2
kelompok perlakuan.
- Kelompok 1 : tikus neonatal generasi pertama (F1) dari induk tikus yang
tidak diberikan MSG
- Kelompok 2 : tikus neonatal generasi pertama (F1) dari induk tikus yang
diberikan MSG peroral setiap hari mulai hari ke-5 kehamilan sampai artum.

Post partum dihentikan.
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Kelompok 3 : tikus neonatal generasi pertama (F1) dari induk tikus yang
diberikan MSG peroral setiap hari mulai hari ke-5 kehamilan sampai masa

laktasi atau menyusui (hingga usia 21 hari post partum).

3.6 Alat dan Bahan Penelitian
3.6.1 Alat Penelitian

T &

o o

u.

V.

o Q —H~ o

Kandang untuk pemeliharaan tikus putih

Tempat pakan dan botol minum tikus

Timbangan untuk mengukur berat badan tikus (Triple Beam Balance, China)
Timbangan untuk mengukur berat MSG (Ohauss, USA)
Sarung tangan dan masker

Pipet tetes

Object glass

Deck glass

Mikroskop cahaya (Olympus, Jepang)

Syiringe

Spidol permanen (Snowman)

Gelas kaca

. Gelas ukur

Gelas kimia
Spatula kaca

Label

Sonde lambung 3ml
Pinset

Gunting bedah
Scalpel

Tissue

Tabung sampel

w. Buku catatan penelitian
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X. Scanning Electron Microscope (Inspect F50, USA)
3.6.2 Bahan Penelitian

Tikus wistar (Rattus norvegicus)

S

Monosodium glutamat (MSG)
Larutan saline (NaCl)
Alkohol 70%

Aquades steril

o o

@

f. larutan formalin 10%
g. Pakan Tikus : Pellet

3.7 Prosedur Pelaksanaan Penelitian
3.7.1 Konversi Dosis

Penentuan dosis MSG mengacu pada dosis yang memicu pengurangan berat
kelenjar tiroid pada mencit, yaitu 2,2 mg/gr BB (Trentini dan Botticelli dalam
Maidawilis 2010). Dosis MSG pada tikus dihitung dengan menggunakan tabel
konversi mencit ke tikus adalah 7,0. Berat rata-rata mencit adalah 20 gram sehingga
diperoleh konsumsi dosis MSG mencit :

2,2 mg/gr x 20 gr = 44 mg/BB
Maka dosis MSG untuk tikus adalah,

7,0 x 44 mg/BB = 308 mg/BB
Berat rata-rata tikus adalah 200 gr, artinya dosis pada tiap gram berat badan tikus
adalah 1,54 mg/gr BB (Harmita et al, 2008). Jika dosis MSG untuk tikus ini
dikonversikan ke manusia maka diperoleh 246,4 mg/kg BB yang artinya dua kali
lipat dari dosis batas normal (120 mg/kg BB) (Budiarso, 2003).
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Hewan ° Mencit Tikus Marmut Kelindi Kucing Kera Anjing Manusia

percobaan 20 g 200g 400g 15ky 2kg dkg I12kg TO0kg

Mencit 1,0 7.0 [N TR R 64, 1242 3879
20¢

Tikus 0,14 10 1,74 19 42 920 AT 8560
200¢

Marmut 0,08 057 1,0 225 24 S U g
400 ¢

Kelinci 0,04 025 0,44 1,0 1,08 24 45 14,2
[, kg

Kucing . 0,03 023 04l D9 2iali0 2y 13,2
1kg

Kera 0016 001 0.9 042 045 0 19 6.l
4kg

Anjing 0008 0086 0,10 D22RN0248 (/60 550 3.
12 kg

Manusia 00026 0018 0,031 007 0076 0l6 032 |0
70 kg

3.7.2 Persiapan Hewan Coba

Tikus betina Rattus norvegicus berumur 2-3 bulan dengan berat badan rata-rata

200-250 gram dipelihara dan ditempatkan dalam kandang. Total jumlah tikus betina

yang digunakan adalah 18 tikus yang dibagi menjadi 3 kelompok perlakuan. Masing-

masing kandang berisi enam tikus betina hamil dengan kelompok perlakuan yang

sama. Induk yang telah melahirkan beserta anaknya akan dilektakkan pada kandang

yang terpisah dari kelompoknya dan diberi label nama kelompok tikus.

3.7.3 Pembuatan Preparat VVaginal Smear

Smear vagina dilakukan dengan pipette smear technique karena teknik ini

hanya memerlukan waktu yang pendek, tanpa perlu pewarnaan dan fiksasi serta

risikonya sangat rendah menunjukkan pseudopregnancy.

1.

Metode ini

dilakukan dengan mengambil sel dari lapisan vagina.

Direkomendasikan menggunakan pipet sekali pakai yang terbuat dari plastik

yang lembut dengan ujung internalnya sekitar 1,5 mm. Pada ujung pipet diisi

dengan larutan saline atau air distilasi 0,2 ml.
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. Tikus betina yang akan dilakukan smear vagina dipegang disekeliling toraks
dan permukaan perut bagian atas, dengan tangan kanan memegang pipet dan
menahan ekornya untuk memberikan dukungan tambahan dan membantu
mencegah tikus bergerak.

. Ujung pipet dimasukkan ke dalam vagina sedalam 2-5 mm dan cairan vagina
diambil dan kembali memasukkan pipet 2-3 kali dengan tekanan yang ringan
dan melepaskan bola pipet. Jika cairan vagina dalam pipet terlihat berawan
atau berwarna putih setelah pengambilan pertama, maka pengambilan
berikutnya tidak dibutuhkan.

. Cairan vagina dalam pipet kemudian diletakkan pada slide atau object glass 1-
2 tetes. Ujung pipet diletakkan di atas slide atau object glass pada sudutnya
ketika menempatkan sampel di atas slide hal ini bertujuan untuk mengontrol
volume dan mencegah kontaminasi yang mungkin terjadi jika tetesan dari
sampel dikeluarkan dari ketinggian.

Dua smear dapat ditempatkan pada satu object glass pada masing-masing
ujungnya kemudian ditutup dengan deck glass agar memastikan kedalaman
smear sama rata atau seragam, selain itu ketika dilakukan pemeriksaan di
bawah mikroskop lebih mudah membuatnya fokus dan mencegah bersatunya
smear selama pergerakan object glass di bawah mikroskop.

Kemudian smear pada object glass diberi label nomor sesuai tanda yang
diberikan pada tikus, tanggal dan jam dilakukannya smear. Smear di lihat di
bawah mikroskop dengan perbesaran 200x kemudian identifikasi siklus
estrus. Jika ditemukan adanya karakteristik sel pada siklus estrus, tikus betina
dimasukkan ke dalam kandang jantan dan pagi hari di lakukan lagi smear
vagina dengan cara yang sama untuk memeriksa adanya sperma jantan. Jika
ditemukan adanya sperma pada hasil smear vagina, maka dihitung sebagai
hamil hari ke-0 (Krinke, 2000).
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Gambar 3.1 Fase Proestrus [A], Fase Estrus [B]

3.7.4 Perlakuan Hewan Coba

a.

Pemeriksaan siklus estrus pada induk tikus betina dengan melakukan smear
vagina teknik pipet smear.

Apabila ditemukan adanya karakteristik sel pada fase estrus, tikus betina
dikumpulkan dengan tikus jantan dalam satu kandang pada sore hari.

Pada pagi hari diperiksa kembali smear vaginanya untuk melihat kehadiran
sperma dalam cairan vagina tikus betina.Jika ditemukan adanya sperma, maka
dihitung sebagai kehamilan hari ke-0.

Tikus betina yang hamil kemudian dipisahkan dalam kandang yang berbeda
dengan tikus betina yang tidak hamil kemudian diberi tanda pada punggung
tikus dengan menggunakan spidol permanen. MSG diberikan secara oral
menggunakan sonde lambung pada 2 kelompok perlakuan, yang dilakukan
setiap hari sejak hari ke-5 kehamilan induk tikus sampai partum pada
kelompok kedua, dan sampai masa laktasi pada kelompok ketiga. Induksi
MSG dilakukan mulai hari ke-5 tikus hamil karena menunggu embrio tikus
mengalami implantasi atau perlekatan di bagian anti-mesometrial uterus.
Praimplantasi embrio tikus terjadi pada hari 1-4 kehamilan dan organogenesis
terjadi pada hari 6-15 kehamilan. Hal ini dilakukan untuk mencegah

teresorpsinya embrio dan berkurangnya fetus hidup oleh karena konsumsi
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MSG sebelum terjadinya implantasi embrio tikus menyebabkan peningkatan
kematian intrauterus (Sabri et al., 2006).

Anak tikus yang lahir dari kelompok kontrol dan kedua kelompok perlakuan
dilakukan dekapitasi pada hari ke-21 postnatal dengan teknik cervical
disclocation.

Dilakukan pengambilan gigi molar rahang bawah kanan tikus untuk

selanjutnya akan dilakukan uji SEM pada struktur enamel gigi tikus.

Persiapan Uji SEM

Rahang bawah kanan tikus Wistar (Rattus norvegicus) diambil dan
dibersihkan dari jaringan lunak dengan menggunakan scalpel, kemudian
dilakukan pemotongan pada bagian distal rahang dan bagian insisif.

Gigi molar diambil dan dibersinkan menggunakan sikat gigi dan air bersih
kemudian dikeringkan.

Gigi tikus dibersihkan dan dikeringkan hingga benar — benar terbebas dari air.
Dilakukan coating dengan emas sebagai pelapis pada sampel dan spesimen
holder.

Sampel dibersihkan dengan menggunakan hand blower kemudian siap

dilakukan pengamatan dengan menggunakan SEM.

3.7.6 Uji SEM

a.
b.

Dilakukan persiapan preparat untuk uji SEM

Sampel yang telah diletakkan dalam holder dimasukkan ke dalam specimen
chamber.

Dilakukan pemotretan dengan menggunakan SEM dengan perbesaran 5000x.
Pada masing — masing sampel dilakukan pemotretan pada 5 lapang pandang
meliputi bukal, palatal, mesial, distal dan lereng cusp gigi molar tikus.
Gambar yang didapatkan dari uji SEM dilakukan pengolahan gambar dengan

menggunakan software ImageJ 1.49V.
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Gambar 3.2 Alat SEM

Pengolahan Gambar

Pengolahan gambar yang didapat dari uji SEM dengan menggunakan
software ImageJ 1.49V.

Klik File pada toolbar, kemudian open dan pilih gambar yang akan
diolah.

Dalam penggunan ImageJ hal pertama yang harus dilakukan untuk
menganalisis ukuran area kerusakan enamel dari gambar SEM adalah
dengan mengkalibrasi ukuran pixel gambar dengan ukuran acuan. Ukuran
acuan biasanya ditampilkan pada hasil gambar SEM berupa garis dengan
skala untuk menunjukkan tingkat perbesaran yang dilakukan. Kalibrasi
dilakukan dengan cara, setelah gambar dibuka kemudian menggambar
garis lurus sepanjang ukuran acuan dengan memilih icon garis pada
toolbar. Set skala yang dipilih dengan klik Analyze > Set Scale.
Selanjutnya pengaturan disesuaikan dengan ukuran acuan dan satuan
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acuan yang digunakan. Centang kolom global untuk menggunakan skala
kalibrasi ini hingga aplikasi ImageJ ditutup (Kurniawan et al., 2011).

d. Tahap selanjutnya adalah menyesuaikan tipe gambar dengan memilih
menu Image > Type > 32-bit.

e. Untuk menganalisa luas area enamel yang porus dapat digunakan menu
Image > Adjust > Threshold. Dengan mengatur level Threshlod maka
dapat terlihat area yang porus akan tertutup dengan warna merah (Gambar
3.2).

{ Imagel o el =
File Edit Image Process Analyze Plugins Window Help q T
: Sampel 24 Skx [21pg (G S [@][=
Oo|z|ofF 4 :zN| Al a|0|F]| vefsw| 4|4 59.88¢56.15 m (1024x943 j
< 8.44%
» 7
[l = [ 125
Default ~ Red -
I~ Dark background [~ Stack histogram
Auto | Apply | Reset| Set

Text tool (double-click to configure)

Gambar 3.3 Pengaturan Treshold pada software ImageJ 1.49V

f. Selanjutnya dilakukan analisa luas area enamel yang porus dengan
menggunakan menu Analyze > Set Measurement > centang Area
Fraction. Untuk mengeluarkan hasil perhitungan klik Analyze >
Measurement dan hasil akan keluar melalui tabel (Kurniawan et al., 2011).

& Results
File Edit Font Results

[Area Mean  |Min |Max [Angle [Circ. [Feret
13302209 147382 0 255 0000 0.003 139208

[E=8 B =)

eret< [Feretv [Feretingle [MinFeret [AR  [Round [Solidity [Length [ -
000 0000 137.358  943.000 1086 0921 1.000 0000

Gambar 3.4 Hasil Pengolahan Gambar dengan Software ImageJ
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g. Hasil yang keluar dari 5 lapang pandang dalam tiap sampel dijumlahkan
dan dihitung sebagai persen area porositas atau kerusakan struktur enamel

pada 1 sampel.

3.8 Analisis Data

Selanjutnya data dari pemeriksaan yang menunjukkan struktur enamel pada
masing-masing kelompok diproses dengan program SPSS. Data yang didapatkan
akan dianalisis dengan menggunakan Kolmogorov-Smirnov sebagai uji normalitas
data, kemudian dilanjutkan dengan uji Levene sebagai uji homogenitas data. Jika data
berdistribusi normal dan varian data homogen, selanjutnya dianalisa dengan
menggunakan uji parametrik one way ANOVA test . Kemudian dilakukan uji beda

menggunakan Post Hoc LSD untuk mengetahui perbedaan masing-masing kelompok.
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3.9 Alur Penelitian
Induk tikus betina usia 2-3 bulan, BB 200-250 ar
v
Smear vagina
\i
Fase estrus
%

Kumpulkan dengan jantan
NR

V -
Smearlvaqma

v
Pembuahan Gestation day ke-0
v
Gestation day ke-5
< v
Kelompok 1 Kelompok 2 Kelompok 3
\ v v
Kontrol Beri MSG Beri MSG
peroral sampai peroral sampai
melahirkan laktasi (21hari)
4 \1/ \l/
Post partum Post partum Post partum
\" \ N
Anak tikus Anak tikus Anak tikus
jantan 5 ekor J'a”tanw5 ekor jantan5 ekor

21 hari post partum

v

Ekstraksi molar

\
Uii SEM
v

Pengukuran area porositas enamel dengan software ImageJ 1.49V

y/
Analisis data

Gambar 3.5 Bagan Alur Penelitian
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BAB 5. KESIMPULAN DAN SARAN

5.1 Kesimpulan

Berdasarkan penelitian yang telah dilakukan, dapat disimpulkan bahwa
pemberian MSG pada induk tikus wistar (Rattus norvegicus) berpengaruh pada
terjadinya kerusakan struktur enamel gigi keturunannya (F1), dalam hal ini terjadi
peningkatan area porositas enamel gigi anak tikus yang dilahirkan pada kelompok
perlakuan (Kelompok 2 sebesar 13,909% dan Kelompok 3 sebesar 18,147%)
dibandingkan kelompok kontrol (Kelompok 1 sebesar 7,039%) .

5.2 Saran

5.2.1 Perlu dilakukan penelitian lebih lanjut mengenai dosis MSG yang bervariasi
sehingga dapat mengetahui dosis minimal yang dapat memicu kerusakan
struktur enamel gigi.

5.2.2 Perlu dilakukan penelitian lebih lanjut mengenai efek MSG terhadap kerusakan
struktur enamel gigi yang dihubungkan dengan adanya kerusakan nukleus
arkuata hipotalamus, hipotiroid dan gangguan endokrin.

5.2.3 Perlu dilakukan penelitian lebih lanjut dan paripurna mengenai efek biologis

konsumsi MSG pada ibu menyusui.
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B. Analisis Data

B.1 Uji normalitas dengan Kolmogorov-Smirnov

One-Sample Kolmogorov-Smirnov Test

50

Kelompok 1 | Kelompok 2 | Kelompok 3
N 3 3 3
Normal Parameters2P  Mean 7.03933 13.84900 18.14667
Std. Dev iation .568226 153727 2.323741
Most Extreme Absolute .368 .289 191
Diff erences Positive .266 .289 191
Negative -.368 -.210 -.182
Kolmogorov-Smirnov Z .637 .501 .331
Asy mp. Sig. (2-tailed) .812 .963 1.000
a. Test distribution is Normal.
b. Calculated from data.
B.2 Uji Homogenitas dengan Levene Statistic
Test of Homogeneity of Variances
Area Porositas (%)
Levene
Statistic df 1 df 2 Sig.
3.347 6 .106
B.3 Uji One Way ANOVA
ANOVA
Area Porositas (%)
Sum of
Squares Df Mean Square F Sig.
Between Groups 188.214 94.107 49.131 .000
Within Groups 11.493 1.915
Total 199.707
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B.4 Uji Post Hoc LSD

Multiple Comparisons
Dependent Variable: Area Porositas (%)
LSD
Mean
Difference 95% Confidence Interval

(1) Kelompok  (J) Kelompok (I-J) Std. Error Sig. Lower Bound | Upper Bound
Kelompok 1 Kelompok 2 -6.809667* | 1.130023 .00 -9.57473 -4.04460

Kelompak 3 11107333 | 1120023 000 -13.87240 -8.34237
Kelompok 2 Kelompok 1 6.809667* | 1.130023 001 4.04450 9.57473

Kelompoak 3 -4 297667 | 1.130023 008 -7.06273 -1.53260
Keluimpok 3 Kelumpok 1 11.107333% | 1.130023 .000 §.34227 13.87240

Kelompok 2 4 297667* | 1.130023 009 1.53260 706273

* The mean difference is significant atthe .05 level.

Kandang Tikus

C. Foto Alat dan Bahan Penelitian
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A : Timbangan untuk mengukur berat badan tikus
B : Holder

A

A : Sarung tangan B : Masker

: Gelas Kaca
: Syringe
: Pipet Tetes Kecil

: Spidol Permanen
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: Label
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A : Deck Glass
B : Object Glass
C : Mikroskop Cahaya

Tabung sampel

Tissue

A : Alas bedah
B : Gunting bedah
C : Pinset
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A : Spatula kaca Timbangan (Ohauss, USA)
B : Gelas kimia
C : Gelas Ukur

Alat Scanning Electrone Microscope (SEM)
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Alkohol 70% MSG Aquades

D. Dokumentasi Pelaksanaan Penelitian
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Pemberian MSG peroral Dekapitasi tikus neonatal

dengan sonde lambung

Penyimpanan rahang dalam formalin

tikus

Induk tikus dan tikus neonatal yang baru lahir
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A : Hasil uji SEM sampel pada
kelompok 1 (Kontrol)

B : Hasil uji SEM sampel pada
kelompok 2 (MSG periode
hamil)

C : Hasil uji SEM sampel pada
kelompok 3 (MSG periode
hamil dan menyusui)
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D : Hasil pengolahan gambar dengan ImageJ pada sampel kelompok 1
E : Hasil pengolahan gambar dengan ImageJ pada sampel kelompok 2

F : Hasil pengolahan gambar dengan ImageJ pada sampel kelompok 3

et - v e

File Edit Font Results

Area i Min [Max X [¥ Feret bATE MinF [Round [salidity | =
1 3245140 120853 0 255 0 O 0003 1392058 0397 O 0000 137358  943.000 0921 1.000
2 3245140 129892 0 255 0 0 (0003 1392058 0863 O 0000 137358 943000 1086 0921 1.000
3 3245140 129187 0 255 0 0 0003 1392058 2613 0 0000 137358 943000 1086 0921 1.000
4 3245140 130087 0 255 0 0 0003 1392058 3.147 O 0000 137358 943000 1.086 0921 1.000
5 3245140 158241 0 255 0 0 0003 1392058 0313 0 0000 137358 943000 1086 0921 1.000 5
6 3245140 182474 0 255 0 0 0003 1392058 0910 0 0000 137358 943000 1.086 0921 1.000 3
7 3245140 147389 0 255 0 0 0003 1392058 6433 0 0000 137358 943000 1.086 0921 1.000
8 3245140 140069 0 255 0 0 0003 1392058 2443 0 0000 137358 943000 1086 0921 1.000
9 3245140 142366 0 255 0 0 0003 1392058 2018 0 0000 137358 943000 1.086 0921 1.000
10 12987443 140718 0 255 0 0 0003 2784793 1903 O 0000 137343  1887.000 1.085 0921 1.000
11 12987443 149243 0 255 0 0 0003 2784793 2810 O 0000 137343  1887.000 1.085 0921 1.000 =
12 12987443 154031 0 255 0 O 0003 2784793 3347 O 0000 137343  1887.000 1085 0921 1.000
13 12987443 157956 0 255 0 0 0003 2784793 2872 O 0000 137343  1887.000 1.085 0921 1.000
14 12987443 138366 0 255 0 0 0003 2784793 3937 O 0000 137343  1887.000 1.085 0921 1.000
15 12987443 127892 0 255 0 O 0003 2784793 2069 O 0000 137343  1887.000 1085 0921 1.000
16 3245140 133546 0 255 0 0 0003 1392058 0862 O 0000 137358 943000 1.086 0921 1.000
17 3245140 143211 0 255 0 0 0003 1392058 0566 O 0000 137358 943000 1.086 0921 1.000
18 3245140 138998 0 255 0 0 0003 1392058 2265 O 0000 137358 943000 1086 0921 1.000
19 3245140 137117 0 255 0 0 0003 1392058 0468 O 0000 137358 943000 1.086 0921 1.000
20 3245140 145392 0 255 0 0 0003 1392058 1823 0 0000 137358 943000 1.086 0921 1.000
21 3245140 168874 0 255 0 0 (0003 1392058 1262 O 0000 137358 943000 1086 0921 1.000
22 3245140 134716 0 255 0 0 0003 1392058 0531 0 0000 137.358  943.000 1.086 0921 1.000

0 255 0 0 0

23 3245140 147425

<

0.003 1392.058 1.221 0.000 137.358 943000 1.086 0.921 1.000 Y

Hasil pada menu result dalam software ImageJ
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E. Data Penelitian
E.1 Tabel Data Penelitian

Area Jumlah Rata — rata jumlah
Kelompok | Sampel | Bagian porositas (%) area porositas
(%) 0 kelompok (%)
Bukal 0,397
Palatal 0,863
Mesial 2,619
11 Distal 3,147 7,339
Lereng 0,313
cusp
Bukal 0,566
Palatal 2,265
Mesial 1,262
12 Distal 1,823 6,384
Lereng
1 cusp 0,468 7,039
(Kontrol) Bukal 2,893
Palatal 0,531
Mesial 1,221
13 Distal 1,338 7,395
Lereng 1,412
cusp
Bukal 0,789
Palatal 0,591
Mesial 14885
& Distal 1,873 s
Lereng 2 451
cusp
Bukal 0,910
Palatal 1,909
Mesial 2,449
) 21 Distal 2,018 13,725
(MSG Ls;ggg 6,439
Sg'rf‘ggae Bukal 4,423
I% amil) Palatal 3,991
2.2 Mesial 0,689 14,201
Distal 1,911
Lereng 3,187
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cusp
Bukal 2,806
Palatal 0,725
Mesial 0,530
23 Distal 2,766 13,801
Lereng 6,974
cusp
Bukal 2,766 13,909
Palatal 6,974
Mesial 2,806
24 Distal 0,725 Y &
Lereng 0,638
cusp
Bukal 2,869
Palatal 2,810
Mesial 3,347
Sl Distal 2,874 e
Lereng 3,097
cusp
Bukal 2,775
Palatal 1,436
Mesial 8,099
3 ik Distal 2,061 20,588
(MSG Lereng 6,167
selama cusp
periode Bukal 1,894
hamil dan Palatal 2,019
menyusui) Mesial 3,310
S Distal 5,804 1800
Lereng 4,978 18,147
cusp
Bukal 2,061
Palatal 6,167
Mesial 2,775
- Distal 1,436 18,14
Lereng 5,708

cusp
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